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OUR NEXT MEETING: 

Thurs., Nov. 8, 2012
7pm at Key Largo Library 

Community Room, 
MM 101.4 Oceanside

“Bring your iPhone5 or 
iPad Mini to the iParty!”

Jack Buccellato of All Keys 
Computer Guy will talk about 
the newest Apple gadgets, fol-
lowed by an interactive demon-
stration of Apple TV, Airplay, 

Mirroring and more. Bring your 
iPhone (any version!), iPod 

Touch, or iPad and join the fun!

Beginners: Come at 6:30 and bring
your Mac and your questions. There
will be some experienced users there
to help for the half-hour before the
formal presentation starts! Experi-
enced users: please come and help!

Pages’09 - a small 
price tag for a lot of 
power!  

by Sue Beal

I’m a publishing professional and an 
admitted Adobe snob. But I am a huge fan 
of  Pages and what it can do for peanuts! 
At just $20 for the desktop or $10 for the 
iPad... you can get some of  the functions 
of  the Adobe Creative Suite and Word 
all rolled into one easy-to-use package.

Pages’09 combines word processing 
and page layout in one program, and does 
both very well. If  you are printing your 
finished products from your desktop, or 
from a color copier, Pages’09 is all you 
need! (Professionals need CMYK output 
capability and Pages doesn’t offer that, so 
for commercial printing some post-Pages 
work is needed.)

Since most presentations on Pages’09 
start with all the cool templates that are 
included with it, I had to be different 
and start from scratch in my UKMUG 
presentation - with a blank word process-
ing (WP) document.

The parts of  the Pages workspace are 
shown on page two. Take your time to 
explore what each symbol is. There is a 
huge amount of  function in those but-
tons at the top. And the Inspector — the 
multifunction palette that comes up on 
the right side — is the key to the whole 
experience! continued on page two

We had a pretty good turnout of  people curious about Pages in October. Karen Sunderland and Leah Zimmerman.

Make beautiful page layouts from scratch, or borrow 
from pre-made templates. It’s easy with Pages’09!

MaryAnne & Jack check out the 
“Island of  Misfit Toys.”

Chris Muller & Jack Buccellato
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continued on page three

Pages’09
continued from page one

The Pages Interface (at the right)

1. Toolbar: includes buttons that are shortcuts 
for some of the commands in the Pages menus.

2. Format Bar: allows you to quickly change the 
settings for the currently selected object.

3. Page Thumbnails: shows small pictures of  
the pages in your document.

4. Document Canvas: this is the main work 
area in Pages, where you will add text, images 
and other content.

5. Inspector: the palette where most Pages set-
tings are found.

6. Status Bar: provides information about your 
document (such as the word count) and includes 
the zoom and navigation options.

Basic Word Processing

Like any WP program, Pages has all the tools for editing text. Click in the blank 
document window and start typing, or paste in some text from elsewhere if  you just 
want to experiment. You need to SELECT IT TO AFFECT IT. Position the cursor 
at the beginning of  the text you want to mess with, and drag through to the end of  it. 
That highlights it (“selects” it), so it is affected by the options you choose next.

Look at the Format Bar (area#2 above). You can change the typeface (font), the 
style (bold, italic, etc.), the size of  type, and the color of  type. The little letter “a” with 
the line through it is a tool for highlighting the type; it puts a colored bar behind the 
selected type (delesect by clicking elsewhere, to better see this). Continuing across the 
Format bar, you can (yet again) choose bold or italic, and apply an underline to the type. 

Pages Text Selection Shortcuts

In a blank WP doc:
Double click on a word

to highlight the whole word.

Triple click and you get
the whole paragraph.

In a templateWP doc:
In a template, the selections behave 

differently! One click on anything and 
it’s all selected. A little strange, to my 

mind, but that’s how it works.

See the button on the extreme right of  
the Toolbar that looks like a letter “A”? 
Click this to pop up the Apple font selec-
tion palette. This is the same font palette 
you see in other Apple programs. It’s just 
another way to choose your text options. 

The same applies for the color selector 
(second button from the right). Noodle 
around with it - there are lots of  ways 
to choose colors! Try the sliders and see 
what happens. Tip: when you have favorite 
colors you want to save to use again, drag 
and drop them into the little boxes at the 
bottom of the color palette.  Your Mac 
remembers them and you’ll see those pre-

selected swatches come up in any other 
Apple programs you use!

 Now we move on to formatting whole 
paragraphs. These alignments affect the 
whole paragraph, no matter how much 
text you have selected.

The next 4 buttons allow you to align 
the paragraph to the left, right, center or 
justify to both margins (like a newpaper 
column.) The little pictures on the buttons 
give you a good idea of  what will happen.

The next tool is for line spacing. Some-
times it’s useful to squeeze out a little space 
between the lines, or fluff  it up a little to fill 
the space. In the publishing world, this is 

Layout Breaks

When you use templates, you automati-
cally get layout breaks, which allow you to 
better control the columns. Try this and I 
promise you’ll understand a lot better how 
Pages works...

When you change the number of  
columns mid-document, you need a 
LAYOUT BREAK. Position the cur-
sor where the change will be. Go to 
Insert>Layout Break. Then click on the 
new number of columns in the Format 
bar. Go to where you want to change 
back to the one-column format, and 
again choose Insert>Layout Break. Then 
click on one column in the Format bar.

called leading. Play with it and you’ll get 
a feel for how much is the right amount.

Next is the Column button. When you 
click it, a popup comes up and you choose 
how many columns you want. It applies 
to the whole document, which may not 
be what you had in mind. See the blue 
box (below) for how to control where and 
when you use multiple columns.

There are invisible characters in all WP 
documents, which control things like 
breaks and tabs. To make this less mys-
terious, go to View>Show Invisibles and 
you can see them. When you’re annoyed 
by all the little symbols, you can go back 
and View>Hide Invisibles!

COLOR PALETTE

Choose the in-
terface you like...
from a color wheel, 
CMYK sliders, 
mutliple palettes of  
swatches, a box of  
crayons, or a web-
friendly palette.

Pages’09 is set up 
in an RGB color-
space.

Store your favor-
ites by dragging 
and dropping here. 

Break Out the Inspector!

There’s a very powerful 
button on the Toolbar, fourth 
one in from the right side; the 
Inspector button. The Inspector is the key 
to the kingdom, it unlocks all the power 
of  Pages!

The content of  this palette is multi-dimen-
sional; there is a row of  buttons across the 

The Pages’09 Workspace.
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top that gives you ten different aspects 
of  your document to play with. Within 
each aspect there are sub-tabs which give 
you even more options. 

I found it very useful to just start go-
ing though everything in the Inspector. 
When I didn’t understand something I 
hovered the cursor over it. (A helpful 
little popup will identify the thing you 
are hovering over.) This would give me 
the name, which I could then Google 
for more help.

In the Document Inspector, Docu-
ment Tab you can set margins, access 
the printer Page Setup, and control your 
Headers and Footers. Hyphenation and 
ligature controls are found here as well. 
You can password protect your document 
at the bottom.

Under the Document Inspector, TOC 
Tab you can set up Table of  Contents 
controls (use this in conjunction with 
Paragraph Styles).

The second Inspector is the Layout 
Inspector. Under it you find detailed 
controls for columns and sections.

Skip the next Inspector and go to the 
“T” button - this is the Text Inspector. 
Under the Text Tab, in addition to the 
things you’ve already seen in the Format 
bar, you can  play with character spacing. 
(This is fun, and can be very useful... try 
it!) You can also change spacing between 
paragraphs.

Under the List Tab, you 
can control listed items. 
Here’s where you can 
have it apply bullets, use 
pictures and other custom 
bullets, color them, resize 
them, respace them, make 
numbered items, and con-
trol the indents...all those 
cool things. Again, play 
with it - hit every option, 
pull down every menu and 
see what it does. There is a 
lot of  function hidden be-
hind this simple interface.

The next Tab under the Text Inspector 
is the Tabs Tab! It’s too complicated to 
completely cover tabs here but just re-
member that you have default tabs every 
half-inch in Pages. Depending on what 
you want it to do, this can be a blessing 
or a curse. If  you already know how to 

Pages
continued from page two

use tabs and want to be in perfect control, 
then highlight your text and remove the 
default tabs before you begin to apply 
your own. To remove a tab, just drag 
its little icon off  the ruler and it will go 
“poof;” to change a tab from left to right 
to center, just double click on the little 
tab icon in the ruler.

Under the Text Inspector‘s More Tab, 
you can control formatting options for a 
text box. (Click the Text Box icon in the 
Toolbar to isolate text in a free-floating 
box.) Add a border rule line around it, 
or above or below, etc., pick the color 
and thickness of  that rule, make it dotted 
or solid; fill the background behind the 
text with color. Set paragraph styles and 
pagination options here, and more. Oh, 
duh, that’s right. It’s the “More” Tab!

Let’s leave the Inspector for a moment. 
Pages has a multitude of  advanced WP 
features. Change tracking, spell check, 
find and replace, sections, page number-
ing... it’s all in Pages’09.

Don’t forget the templates!

Open up and look at some of  Page’s 
templates for word processing. They 
might be just the ticket to easily lend 
some style to your next correspondence! 
Page Layouts in Page’09

There are so many cool things you can 
do to make attractive pages in Pages! 
Posters, flyers, brochures, rack cards... 
anything you need to put on a page goes 
together easily in this amazing program!

Use the Media Inspector 
button (third from the right 
in the Tool Bar) to open a 
window into your iPhoto, 
iTunes, and iMovie librar-
ies. I haven’t quite figured 
out  why you would want a 
movie or music in a brochure 
(Harry Potter’s newspapers 
come to mind), but I think 
you can take Pages docu-
ments and put them into 
iWeb to make web pages.

It is really handy to have 
the photo tab active. Point it 

at iPhoto or wherever you put the photos, 
clip art or other images you want to use 
in your document. 

Continuing with the goal of  printing 
what we make, we have some more 
Inspectors (under the circle-i Inspector 
button) to look at. These are where magic 
happens!

The Graphic Inspector relates to shapes 
you draw with the Shapes Tool in the 
Toolbar. Select the shape, resize with the 
little handles that pop up, and click away 
to see all the things you can do!

You can fill with a color, or a gradient 
(a color that shifts from, say, red to yel-
low—you choose). Advanced Gradients 
lets you choose radial and off-center op-
tions. Fill with an image or photo, tint or 
fade the image, resize, rotate or crop it. 
Choose a border line, dotted line, picture 
frame (there are about a dozen frames, 
some are really cool!). Scale the effects, 
add a drop shadow, color the shadow, 
change the softness and angle... even add 
a reflection. Get clicking on those but-
tons and you’ll be amazed at how easy 
it is the make really cool looking effects!

Gloria and Dave. Gloria won the door prize, 
awarded for the best question... 

This was the door prize... a beautiful balloon 
orchid by Kathy Miller! Kathy makes custom 
balloon artistry for any occasion - call her at 
305-304-8861 next time you need something 
really special! 

continued on page four
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Pages
continued from page two

All Keys

Multimedia Integration
(AppleTV, Music, Movies
and Photos)

Service, Support and
Education Specialists

Mobile Computing Services  
We Come To You!







www.abbyscomputertutors.com

Getting Subsequent                              
Pages of Templates

When you first mouse over a template 
in Pages, you see the image change. This 
is showing you the multiple page layouts, 
all related to the same theme, for the tem-
plate you are viewing. Yet once you open 
a template, you usually only see one page. 
What happened to the subsequent pages?

They’re still there, but you have to ask 
nicely for them! Go to Insert>Pages> and 
look at the choices it gives you. Pick what 
you want, and it comes in. Pop out the 
Page Thumbnails (use the View Button 
on the left side of  the Toolbar) to see all 
of  your pages and their order.

To do some image editing once a 
photo is in Pages, go to View>Show 
Adjust Image. Contrast, Brightness, 
etc. is there.

How does your image relate to your 
text on the page? That’s controlled by 
the Object Placement Inspector, which 
is the one we skipped over, third from 
the left. Sometimes it’s useful to have 
a graphic flow with text, sometimes 
you’d rather it push all the text out of  
its way (this is called Text Wrap). Set 
all those options in the Object Place-
ment Inspector

The last Inspector we covered in detail 
was the Metrics Inspector. This one con-
trols positioning of  your graphics and 
elements. Rotation angle, size, position 
on the page, flipping it, and whether it 
constrains to the original proportions 
when stretched (it’s very useful to be 
able to turn this on and off).
Charts and Tables and Links, Oh My!

There are 3 more Inspectors. One 
for Tables, one for Charts, and one for 
Links. We didn’t cover these, in the 

interest of  time. I am not sure I can 
unconditionally recommend Pages for 
complex Tables and Charts. You may 
want to create these in a more fully 
featured program and drop them in, if  
you are creating a seriously scientific 
document. But for simple tables and 
some cool charting options... Pages 
has it covered.

Hyperlinks and bookmarks can be 
added in the Links Inspector. That’s also 
where mail merge links are set up.
Options for Saving

You save pages documents as .pages. 
But you can also export Word documents, 
PDF files, or RTF or TXT files. To prepare 
your document for commercial printing, 
make sure you’ve chosen CMYK-safe 
colors, use high res images and export 
a PDF with “high quality” selected. A 
graphics professional can take that to the 
next level and prepare it for the press.

We ran through some options for saving 
and converting file formats that anyone 
can use - not limited to Pages users... see 
the box below for some great tips.

CONVERTING FILE FORMATS
A Quick Guide

In any program on your Mac, you 
can make a PDF simply by hitting 
“print.” At the bottom of  the print 
screen, there’s a button “PDF.” 
Under that button you can save as a 
PDF, or as a postscript file, you can 
email it, fax it, save it to iPhoto... you 
have all kinds of  options!

Have a PDF or PNG, need a JPG?

Use Preview (comes with your 
Mac) to open the document, then 
under the file menu, Save As... then 
choose JPG. You can set some op-
tions about the JPG size and clarity 
there. You can do other conversions 
as well... check it out!

Default to Preview

Make Preview your default pro-
gram for opening PDFs by selecting 
any PDF file, then using Command-i 
to bring up the info box. Look down 
the column and you’ll see “open 
with.” Select Preview and all PDFs 
will open with Preview in the future, 
just by double-clicking them.
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from page four

Clip Art & Pages

Pages doesn’t have a built-in clip art 
library, which is a disappointment for 
most folks.  However, it’s not hard to find 
beautiful images to use. You can drag 
them all to a folder and open that with 
the Media Inspector, or simply drag and 
drop the graphics in from your desktop.

Here are some sources:

•  There’s a wealth of  images in Page’s 
templates! You might have to unlock 
an element to grab it, but there are 
tons of  great graphics for the taking. 
See the samples here that Karen pulled 
to show us. Remember to look on the 
subsequent pages of  the templates for 
even more goodies (see the green box).

•  Google Images is a great place to get 
graphics. Use the items down the side. 
Stick to medium or large size graphics 
to avoid fuzzy, pixilated images. You 
can specify whether you want clip 
art, black and white, lots of  choices. 
Remember, when you see an image in 
the window, follow the link to the source. 
Then just drag and drop the image 
into your clip art folder. Rename it 
something meaningful.

• Scrapbooking sites are a wonderful 
place to get themed graphics for per-
sonal use.

•  If  you plan to publish commercially 
(not for personal use) make sure you 
only choose graphics that are not 
copyrighted.

POWER TIP:

Don’t like the white box on clip art? 
Highlight the image, and choose 
Format>Instant Alpha  to remove it!

HELP for PAGES’09

The built-in HELP is fabulous. Follow 
these links for more great sources of  

Pages’09 information:

Apple’s official Pages’09 Manual:
manuals.info.apple.com/en/pages_

userguide.pdf 

Apple’s Pages’09 Video Tutorials:
http://www.apple.com/iwork/

tutorials/#pages-hero

Pages ‘09 Toolbox eBook:
http://issuu.com/ktenkely/docs/pages

An excellent tutorial PDF from Florida 
Center for Instructional Technology:

etc.usf.edu/te_mac/movies/pdf/
pages09.pdf 

iWork’09 - the Missing Manual 
(Requires signup/payment, gives 10 

days free trial): 
http://my.safaribooksonline.com/

book/office-and-productivity-
applications/9780596802073

Free Templates for Pages’09
http://www.iworkcommunity.com/

Pages for the iPad
Just $9.99 at App Store

Pages is available for iPad. Documents 
look stunning on the bright, vivid iPad 
display. Use Multi-Touch gestures to lay out 
letters, flyers, brochures, reports, and more. 
You can start with a template or import 
an existing Pages or Microsoft Word 
document from Mail, your MobileMe 
iDisk, or a WebDAV service.

Pages makes it easy to edit and format 
your document. Style text, insert tabs, 
and set indents and margins with the 
streamlined style ruler. Use the Media 
Browser to add photos and videos from 
your Photos app. And make them look 
great with masks, shadows, reflections, 
and picture frames. 

You can resize, rotate, and move im-
ages around the page, and dynamic word 
wrapping automatically flows your text 
around them. Tap to layout your text 
in multiple columns or insert tables to 
organize your data. 

When your document is complete, 
use full-screen view to show your work 
right on your iPad. You can also send 
your document to anyone in Pages ’09, 
Microsoft Word, or PDF format.Using 
AirPrint, you can send your document to 
a printer on your wireless network.

manuals.info.apple.com/en/pages_userguide.pdf
manuals.info.apple.com/en/pages_userguide.pdf
http://www.apple.com/iwork/tutorials/#pages-hero
http://www.apple.com/iwork/tutorials/#pages-hero
http://issuu.com/ktenkely/docs/pages
etc.usf.edu/te_mac/movies/pdf/pages09.pdf
etc.usf.edu/te_mac/movies/pdf/pages09.pdf
http://my.safaribooksonline.com/book/office-and-productivity-applications/9780596802073
http://my.safaribooksonline.com/book/office-and-productivity-applications/9780596802073
http://my.safaribooksonline.com/book/office-and-productivity-applications/9780596802073
http://www.iworkcommunity.com/
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Florida Keys on the Cheap
by Karen Beal

I signed up for emails from  http://flori-
dakeysonthecheap.com/  and  every once 
in a while there is something I actually use 
- but lots of  stuff  offered - a few each day.

Free museum and park admissions... art 
events, aquarium... have some cheap fun - 
take the kids or grands if  you have them!

If  you work with a group that has an 
event that is free - or offers a good deal or 
discount - get on the list. 

List of free, useful tools from                       
Scoop It Transmedia Blog

submitted by Karen Beal
Tools for collaboration/sharing

Google+ Hangouts has become my 
preferred tool for video-conferencing. 
Unlike Skype, which charges for video 
meetings with multiple participants, this 
service is free on Google+. You can also 
stream Hangouts live and save to YouTube 
making this a great tool for live-streaming 
events or creating video podcasts.

Google Docs. I’ve wasted many hours 
searching for the perfect tool for project 
management and team-based collabora-
tion. In the end I haven’t found anything 
that works better than Google Docs. Call 
me old-fashioned, but nothing beats a good 
spreadsheet. 

D r o p b o x  a n d 
wetransfer are tools 
that I wonder how I 
ever managed with-
out. Dropbox lets me 
sync all my important 
files so I can access 
them wherever and 
whenever I need them and share files with 
people I’m working with. wetransfer is 
great for occasions when I need to send 
a file that’s just too big to email. And it 
looks pretty.

Prezzi is an attractive alternative to Pow-
erpoint for making snappy presentations 
(though its transitions have been known 
to cause motion sickness when not used 
carefully). However, I also find Prezzi to be 
a useful way to map out ideas and gather 
resources. It’s fast and easy to drop in im-
ages and video and make diagrams, so it 
can be very effective as a workspace and 
it’s easy to share with others.

Wordpress is far more 
than a blogging platform. 
There’s a huge variety 
of  templates for creat-
ing a website for almost 
any purpose and the 
Wordpress platform is 

extremely user-friendly. There’s no longer 
any excuse for a static site that only the 
elusive ‘web guy/girl’ can maintain. With 
Wordpress you can have a site up for your 
project or portfolio that anyone in your 
team can use in a matter of  hours.  This 
is one tool where the free version is pretty 
good, but it’s really worth paying a bit extra. 
Purchase your own domain rather than 
using Wordpresscom’s free hosting and 
spend a little extra (up to $100) on a qual-
ity theme. (Check out Elegant Themes and 
Press75 for examples of  premium themes).

Tools for organization

Workflowy is the ultimate to-do list. 
Very simple, very effective and accessible 
from anywhere.

Evernote has allowed me to retire the 
collection on notebooks I used to carry 
around with me. Now my notes are synced 
between my work and home computers 
and my phone. I can record audio, take 
a snapshot, clip things from the web and 
attach files to notes, which is very handy. 
I like working in Evernote so much that I 
even used it to write this blog post.

Dropmark is similar to Pinterest, but not 
as social. You can keep your collections 
private or share with invited users. See eg 
http://chooseyouripsum.com/ for a demo.  
Also, like wetransfer, it looks pretty. (Yes, 
this is important).

Strong Passwords
by Jack Buccellato

You can have strong passwords and still 
be able to remember them. You need three 
passwords...
Generic Password

Pick something easy to remember for 
when you have to log in to a site where 
the consequences of  anyone guessing this 
password would be negligible.
Strong Password

Take a word or phrase - maybe your 
favorite catch phrase or the first few words 
of  a quote. Spell it uniquely, in your own 
way. Transpose some numbers for letters 
- i=1; B=8; E=3... like that.

This mid-level security is good for 
iTunes, email and other account-driven 
sites, where it would be inconvenient if  
someone guessed your password.
Ultra-Super-Secret Password

Start like the strong password above but 
use special characters as well. Stay away 
from exclamation points, parentheses or 
periods, as these have spacial meanings in 
computer code and can mess you up. Use 
underscore, hyphen, asterisk, etc. Use up-
per and lower case letters too.

Use this one for your bank account and 
other high-security needs.

Write the 3 passwords down a few times. 
Really get them drilled into your brain. 
Then eat the paper. You can also store 
them as secure notes in Keychain.

http://floridakeysonthecheap.com/
http://floridakeysonthecheap.com/
http://chooseyouripsum.com/
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How to Lock Your 
iPhone Screen in the 
Upright Position  

by Anne P. Mitchell, Esq. Internet Patrol 
(03-31-2012)  www.InternetPatrol.com

If  you get frustrated when your iPhone 
screen switches from the upright position 
(known as “portrait” view) to the horizontal 
orientation (known as “landscape” view) 
at the slightest change swivel of  your wrist, 
you may have gone searching for a way to 
lock the orientation so that doesn’t happen. 
On the iPad, there is an external button 
to lock the orientation of  the screen, but 
on the iPhone that same button serves the 
mute function. Here’s how to lock your 
iPhone screen so that it is locked in the 
portrait orientation.

If  you get frustrated when your iPhone 
screen switches from the upright position 
(known as “portrait” view) to the horizontal 
orientation (known as “landscape” view) 
at the slightest change swivel of  your wrist, 
you may have gone searching for a way to 
lock the orientation so that doesn’t happen. 
On the iPad, there is an external button 
to lock the orientation of  the screen, but 
on the iPhone that same button serves the 
mute function. Here’s how to lock your 
iPhone screen so that it is locked in the 
portrait orientation.

First, double-click 
your “home” button 
twice - that is the physi-
cal button at the bottom 
of  your phone that 
takes you to the home 
screen.If you click it 
once, you go to the 
home screen, but if  you 
click it twice it displays 
that “recent apps” row 
at the bottom.

When the “recent apps” row appears 
after you double-click your home button, 
swipe the recent apps row towards the right. 
This will reveal the audio (music) tool bar 
in place of  the “recent apps”, but you will 
also see, in the far lower left, this icon:

Simply press on that 
icon, and it will lock 
your screen!

To unlock your screen 
orientation, simply 
press on the icon again.

For some reason this will only work to 
lock your screen in the portrait (upright) 
orientation, not landscape (horizontal). 
But it’s still a pretty useful trick!

iPhone Photography 
Guide

Leanna Lofte has written a guide to us-
ing the iPhone’s camera for iMore.com.  
It is aimed at the iPhone 4S, but much 
of  it would be appropriate for any of  the 
iPhone cameras.

The guide is actually a collection of  
articles that makes up the full guide.  
Topics are:
• How to get started with iPhone pho-

tography
• How to make your iPhone photography 

more striking with the “rule of  thirds”
• How to make your iPhone photographs 

more powerful with negative space
• How to take amazing macros with 

your iPhone
• How to take stunning panoramas with 

your iPhone
• How to take awesome HDR photos 

with your iPhone
• How to take great looking portraits with 

your iPhone camera
• How to take fantastic photos of  your 

kids with your iPhone
• How to take dreamy iPhone photos of  

your newborn baby
• How to take irresistible photos of  your 

pets with your iPhone
• How to take spectacular photos of  your 

car with your iPhone
• How to use iPhoto to darken and add 

drama to your iPhone photography
• How to use iPhoto to polish and perfect 

your iPhone portraits
• All iPhone Camera app how-tos
• All iPhone Photos app how-tos
• iPhone photography forum

Some of  these articles are very basic, 
so it is a great place to start.  Others are 
more specific and would help virtually any 
camera.  The forum is used to discuss the 
articles and photography in general.

See the collection with the links and 
examples here: http://www.imore.com/
iphone-photography-ultimate-guide

http://www.imore.com/iphone-photography-ultimate-guide
http://www.imore.com/iphone-photography-ultimate-guide
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Apple is now tracking users through IFA 
(or IDFA) tracking technology with the iOS 6 
update. While Apple had disabled the tracking 
of  iPhone users by advertisers by disallowing 
app developers from using the data from Apple 
devices through the unique serial number per-
manently assigned to each device, it seems that 
iOS 6 has brought tracking back.

IFA/IDFA stands for “identifier for advertis-
ers” and is an anonymous number assigned to 
each user and the device that they are using. 
When you browse a website or view an app, the 
publisher of  that site will pass along your IFA 
to the ad server. With the IFA, advertisers can 
track your browsing and send ads to your phone 
based on what you are viewing. Unlike previous 
ad-tracking models, through IFA advertisers can 
track each specific user all the way to “conver-
sion” - which means that they can now see if  
you actually purchased anything, or downloaded 
an app, as a result of  their advertising efforts.

While it should be noted that you are not 
identified personally through IFA, as it only 
provides advertisers with aggregate audience 
data, it is still something that many users would 
prefer to opt out of. And many do not even 
realize that opting out is an option, as that was 

iPhone 5’s iOS 6 Automatically Opts You In 
to Being Tracked by Advertisers by Default - 
Here’s How to Turn it Off  

by Jessica Harris, Internet Patrol (10-14-2012)  www.InternetPatrol.com

conveniently not mentioned on the iOS 6 launch 
page. If  you have an Apple device running iOS 
6, you’re automatically defaulted to tracking.

Apple does not make it easy to opt-out of  being 
tracked, in fact, they got downright sneaky with 
it. For starters, many would understandably as-
sume that the way to opt-out of  tracking would 
simply be to go to your “Privacy” menu. But 
Apple has made it much more complicated than 
it needs to be. Instead you must go to “Settings”

Then “General”
Then choose “About” and scroll all the way 

down to “Advertising”
Then switch “Limit Ad Tracking” to ON 

rather than OFF - another way that Apple has 
made the opt-out process even more confusing.

While the tracking does not supply personal 
information, many are less than happy that the 
opt-in is automatic and remaining unannounced 
by Apple.

 Those angry masses don’t, of  course, include 
advertising companies like Mobile Theory. Says 
Mobile Theory CEO Scott Swanson, “The big-
gest thing we’re excited about is that it’s on by 
default, so we expect most people will leave it 
on.” Well now you are informed and have the 
option to turn it off, if  you so wish.
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FREE OS X CLASSES
The Apple Store at the Falls has free OS X 

classes every  Saturday from 9-10 am!  They 

also have one-on-one training, workshops 

and the Genius Bar. Call for more info:

Apple Store at The Falls
305-234-4565 

8888 SW 136th Street
Miami, FL 33176  
Mon-Sat:10-9:30pm
Sun: noon-7pm

http://www.apple.com/retail/thefalls

Come at
6:30 for the

Beginners Circle:
Bring your laptop 

and your questions 
at 6:30, and for a half-hour
prior to the main meeting 

we'll have experienced 
folks available to help, 

one on one, or in 
small groups.

FREE CLASSES IN KEY WEST!
Macintosh™ Systems Solutions has a free class 

almost every Saturday morning at the store in Key 
West! Visit them at 1001 Truman Avenue at the cor-
ner of  Grinnell. They offer a wide range of  classes 
for new and experienced Mac users. Stop by for all 
your Apple sales, service, and training needs, or call 
293-1888.

Did you see that picture of you, taken
at the last meeting? 

http://ukmug.pbworks.com/

dummies.com 
is a great place for
 useful and brief          

Mac Tips and Tricks! 
Check it out!

Color Copies •  Large or Small Orders
Rack Cards • Business Forms & Checks • Brochures

Business Cards • Letterhead • Envelopes

Signs and Banners • Multi-Part Forms • RX pads 

Posters • Rubber Stamps • Graphic Design

305-664-1002 
81933 Overseas Hwy., Islamorada

printsourcekeys@yahoo.com

Free 
Manual 
for New 
Mac 
Users!

This 69-page PDF guide 
(from Makeuseof.com) sup-
plies you with numerous tips, 
tricks and free applications. 

Download it from http://
ukmug.pbworks.com/

The Official Newsletter of the Upper Keys Macintosh Users Group August 1993                   Volume 1, Issue 1

is the official newsletter of the

Upper Keys Mac Users Group
A nonprofit organization devoted to the use (and 
sometimes abuse) of the Macintosh computer. 
Subscriptions are $25.00 for one year. Contents © 
1993 - 2011 by the Upper Keys Macintosh Users 
Group except where noted. All other rights reserved. 

219 Second St. • Key Largo FL 33037
(305) 451-4601 • ukmug@bellsouth.net

VISIT TODAY!
http://ukmug.pbworks.com/

Post questions and requests for help
Post tips and tricks

Post your favorite links
Check on upcoming meetings

Download our newsletters & more!

Monroe County Recycling
 Collection Center: MM 100.1 

Oceanside (Magnolia St.) 
453-0788

E-RECYCLING: 2nd & 4th Wed. 
every month, 10am - 2pm 

E-waste: Monitors & Computers
 Batteries, Televisions, All Telephones
& FAX Machines, Printers / Copiers, 

DVD / VCR Players, Radios & 
Speakers, Discs & Cassettes 

Also taking Hazardous Household Waste.

Free Ink Cartridges
I have some brand new, never opened ink car-
tridges that I don’t have a printer for. It’s HP 
- 45/23 Inkjet. I have one color and 2 black and 
would love to give them to someone to use—I 
hate wasting stuff!

JUST CALL ME IF YOU WANT THEM...

305-367-3467  - Patsy Cummings
Insurance By Kaiser, Inc.
31 Ocean Reef  Drive, Suite A-202
Key Largo, FL 33037

11 tricks for iPhone, 
iPad and iPod 
earphones

by Adrian Kingsley-Hughes, zdnet.com

Eleven tips to help you get the more out 
of  the remote control fitted to Apple ear-
phones, or EarPods as they are now called:

h t t p : / / w w w. z d n e t . c o m / 1 1 -
tricks-for-iphone-ipad-and-ipod-ear-
phones-7000005410/

http://www.apple.com/retail/thefalls
http://ukmug.pbworks.com
dummies.com
Makeuseof.com
http://ukmug.pbworks.com
http://ukmug.pbworks.com
mailto:ukmug@bellsouth.net
http://ukmug.pbworks.com
http://www.zdnet.com/11-tricks-for-iphone-ipad-and-ipod-earphones-7000005410/
http://www.zdnet.com/11-tricks-for-iphone-ipad-and-ipod-earphones-7000005410/
http://www.zdnet.com/11-tricks-for-iphone-ipad-and-ipod-earphones-7000005410/

